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~ WARNING ~
Thank you for purchasing automation equipment from Automationdirect.com®, doing business as, 
AutomationDirect.  We want your new automation equipment to operate safely.  Anyone who installs or uses this 
equipment should read this publication (and any other relevant publications) before installing or operating the 
equipment.
To minimize the risk of potential safety problems, you should follow all applicable local and national codes that 
regulate the installation and operation of your equipment.  These codes vary from area to area and usually 
change with time.  It is your responsibility to determine which codes should be followed, and to 
verify that the equipment, installation, and operation is in compliance with the latest revision of these 
codes.
At a minimum, you should follow all applicable sections of the National Fire Code, National Electrical Code, 
and the codes of the National Electrical Manufacturer’s Association (NEMA).  There may be local regulatory or 
government offices that can also help determine which codes and standards are necessary for safe installation 
and operation.
Equipment damage or serious injury to personnel can result from the failure to follow all applicable codes 
and standards.  We do not guarantee the products described in this publication are suitable for your particular 
application, nor do we assume any responsibility for your product design, installation, or operation.
Our products are not fault-tolerant and are not designed, manufactured or intended for use or resale as on-line 
control equipment in hazardous environments requiring fail-safe performance, such as in the operation of nuclear 
facilities, aircraft navigation or communication systems, air traffic control, direct life support machines, or weapons 
systems, in which the failure of the product could lead directly to death, personal injury, or severe physical or 
environmental damage (“High Risk Activities”).  AutomationDirect specifically disclaims any expressed or implied 
warranty of fitness for High Risk Activities.
If you have any questions concerning the installation or operation of this equipment, or if you need 
additional information, please call us at 1-770-844-4200.
This publication is based on information that was available at the time it was printed.  At 
AutomationDirect we constantly strive to improve our products and services, so we reserve the right to 
make changes to the products and/or publications at any time without notice and without any obligation.  This 
publication may also discuss features that may not be available in certain revisions of the product.

Trademarks
This publication may contain references to products produced and/or offered by other companies.  The product 
and company names may be trademarked and are the sole property of their respective owners. AutomationDirect 
disclaims any proprietary interest in the marks and names of others.

Copyright 2017, Automationdirect.com® Incorporated 
All Rights Reserved

No part of this manual shall be copied, reproduced, or transmitted in any way without the prior, written consent of 
Automationdirect.com® Incorporated.  AutomationDirect retains the exclusive rights to all information included in 
this document.
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ReeR MOSAIC example

Wiring an E-STOP and controlling two safety 
devices with EDM and manual reset

Please refer to the Safety Components Disclaimer which follows these examples

M1 or M1S Module Connections
Terminal Signal Description

1 24VDC 24VDC power supply
2* MASTER_ENABLE1 Master Enable 1
3* MASTER_ENABLE2 Master Enable 2
4 0VDC 0VDC power supply
5 OSSD1_A

Static output 1
6 OSSD1_B

7
RESTART_FBK Feedback/Restart 
OUT_STATUS Programmable signal output

8
RESTART_FBK Feedback/Restart
OUT_STATUS Programmable signal output

9 OSSD2_A
Static output 2

10 OSSD2_B

11
RESTART_FBK Feedback/Restart 
OUT_STATUS Programmable signal output

12
RESTART_FBK Feedback/Restart
OUT_STATUS Programmable signal output

13 OUT_TEST1 Short circuit detected output
14 OUT_TEST2 Short circuit detected output
15 OUT_TEST3 Short circuit detected output
16 OUT_TEST4 Short circuit detected output
17 INPUT1 Digital input 1
18 INPUT2 Digital input 2
19 INPUT3 Digital input 3
20 INPUT4 Digital input 4
21 INPUT5 Digital input 5
22 INPUT6 Digital input 6
23 INPUT7 Digital input 7
24 INPUT8 Digital input 8

* Terminals 2 and 3 are not connected on the M1S.
Note: The MOSAIC M1 or M1S Master Controller includes a USB 2.0 con-
nector for connection to a computer and the MSD (Mosaic Safety Designer) 
configuration software. A USB cable is available as an accessory.

Blue-highlighted cells apply only to M1S controller.
See manual for further information.

MOSAIC M1 or M1S



6

ReeR MOSAIC example

Controlling two safety devices with a light curtain 
and an E-STOP with EDM and manual reset

Please refer to the Safety Components Disclaimer which follows these examples

Blue-highlighted cells apply only to M1S controller.
See manual for further information.

MOSAIC M1 or M1S
M1 or M1S Module Connections

Terminal Signal Description
1 24VDC 24VDC power supply
2* MASTER_ENABLE1 Master Enable 1
3* MASTER_ENABLE2 Master Enable 2
4 0VDC 0VDC power supply
5 OSSD1_A

Static output 1
6 OSSD1_B

7
RESTART_FBK Feedback/Restart 
OUT_STATUS Programmable signal output

8
RESTART_FBK Feedback/Restart
OUT_STATUS Programmable signal output

9 OSSD2_A
Static output 2

10 OSSD2_B

11
RESTART_FBK Feedback/Restart 
OUT_STATUS Programmable signal output

12
RESTART_FBK Feedback/Restart
OUT_STATUS Programmable signal output

13 OUT_TEST1 Short circuit detected output
14 OUT_TEST2 Short circuit detected output
15 OUT_TEST3 Short circuit detected output
16 OUT_TEST4 Short circuit detected output
17 INPUT1 Digital input 1
18 INPUT2 Digital input 2
19 INPUT3 Digital input 3
20 INPUT4 Digital input 4
21 INPUT5 Digital input 5
22 INPUT6 Digital input 6
23 INPUT7 Digital input 7
24 INPUT8 Digital input 8

* Terminals 2 and 3 are not connected on the M1S.
Note: The MOSAIC M1 or M1S Master Controller includes a USB 2.0 con-
nector for connection to a computer and the MSD (Mosaic Safety Designer) 
configuration software. A USB cable is available as an accessory.
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ReeR MOSAIC example

Controlling two safety devices with an E-GATE 
with EDM and manual reset

Please refer to the Safety Components Disclaimer which follows these examples

Blue-highlighted cells apply only to M1S controller.
See manual for further information.

MOSAIC M1 or M1S
M1 or M1S Module Connections

Terminal Signal Description
1 24VDC 24VDC power supply
2* MASTER_ENABLE1 Master Enable 1
3* MASTER_ENABLE2 Master Enable 2
4 0VDC 0VDC power supply
5 OSSD1_A

Static output 1
6 OSSD1_B

7
RESTART_FBK Feedback/Restart 
OUT_STATUS Programmable signal output

8
RESTART_FBK Feedback/Restart
OUT_STATUS Programmable signal output

9 OSSD2_A
Static output 2

10 OSSD2_B

11
RESTART_FBK Feedback/Restart 
OUT_STATUS Programmable signal output

12
RESTART_FBK Feedback/Restart
OUT_STATUS Programmable signal output

13 OUT_TEST1 Short circuit detected output
14 OUT_TEST2 Short circuit detected output
15 OUT_TEST3 Short circuit detected output
16 OUT_TEST4 Short circuit detected output
17 INPUT1 Digital input 1
18 INPUT2 Digital input 2
19 INPUT3 Digital input 3
20 INPUT4 Digital input 4
21 INPUT5 Digital input 5
22 INPUT6 Digital input 6
23 INPUT7 Digital input 7
24 INPUT8 Digital input 8

* Terminals 2 and 3 are not connected on the M1S.
Note: The MOSAIC M1 or M1S Master Controller includes a USB 2.0 con-
nector for connection to a computer and the MSD (Mosaic Safety Designer) 
configuration software. A USB cable is available as an accessory.
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ReeR MOSAIC example

Controlling two safety devices with an E-STOP 
and an E-GATE with EDM and manual reset

Please refer to the Safety Components Disclaimer which follows these examples

Blue-highlighted cells apply only to M1S controller.
See manual for further information.

MOSAIC M1 or M1S
M1 or M1S Module Connections

Terminal Signal Description
1 24VDC 24VDC power supply
2* MASTER_ENABLE1 Master Enable 1
3* MASTER_ENABLE2 Master Enable 2
4 0VDC 0VDC power supply
5 OSSD1_A

Static output 1
6 OSSD1_B

7
RESTART_FBK Feedback/Restart 
OUT_STATUS Programmable signal output

8
RESTART_FBK Feedback/Restart
OUT_STATUS Programmable signal output

9 OSSD2_A
Static output 2

10 OSSD2_B

11
RESTART_FBK Feedback/Restart 
OUT_STATUS Programmable signal output

12
RESTART_FBK Feedback/Restart
OUT_STATUS Programmable signal output

13 OUT_TEST1 Short circuit detected output
14 OUT_TEST2 Short circuit detected output
15 OUT_TEST3 Short circuit detected output
16 OUT_TEST4 Short circuit detected output
17 INPUT1 Digital input 1
18 INPUT2 Digital input 2
19 INPUT3 Digital input 3
20 INPUT4 Digital input 4
21 INPUT5 Digital input 5
22 INPUT6 Digital input 6
23 INPUT7 Digital input 7
24 INPUT8 Digital input 8

* Terminals 2 and 3 are not connected on the M1S.
Note: The MOSAIC M1 or M1S Master Controller includes a USB 2.0 con-
nector for connection to a computer and the MSD (Mosaic Safety Designer) 
configuration software. A USB cable is available as an accessory.
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ReeR MOSAIC example

Controlling two safety devices with a Safety Mat 
or Safety Edge with EDM and manual reset

Please refer to the Safety Components Disclaimer which follows these examples

Blue-highlighted cells apply only to M1S controller.
See manual for further information.

MOSAIC M1 or M1S
M1 or M1S Module Connections

Terminal Signal Description
1 24VDC 24VDC power supply
2* MASTER_ENABLE1 Master Enable 1
3* MASTER_ENABLE2 Master Enable 2
4 0VDC 0VDC power supply
5 OSSD1_A

Static output 1
6 OSSD1_B

7
RESTART_FBK Feedback/Restart 
OUT_STATUS Programmable signal output

8
RESTART_FBK Feedback/Restart
OUT_STATUS Programmable signal output

9 OSSD2_A
Static output 2

10 OSSD2_B

11
RESTART_FBK Feedback/Restart 
OUT_STATUS Programmable signal output

12
RESTART_FBK Feedback/Restart
OUT_STATUS Programmable signal output

13 OUT_TEST1 Short circuit detected output
14 OUT_TEST2 Short circuit detected output
15 OUT_TEST3 Short circuit detected output
16 OUT_TEST4 Short circuit detected output
17 INPUT1 Digital input 1
18 INPUT2 Digital input 2
19 INPUT3 Digital input 3
20 INPUT4 Digital input 4
21 INPUT5 Digital input 5
22 INPUT6 Digital input 6
23 INPUT7 Digital input 7
24 INPUT8 Digital input 8

* Terminals 2 and 3 are not connected on the M1S.
Note: The MOSAIC M1 or M1S Master Controller includes a USB 2.0 con-
nector for connection to a computer and the MSD (Mosaic Safety Designer) 
configuration software. A USB cable is available as an accessory.
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ReeR MOSAIC example

Controlling two safety devices with a 
Light Curtain with EDM and manual reset

Please refer to the Safety Components Disclaimer which follows these examples

Blue-highlighted cells apply only to M1S controller.
See manual for further information.

MOSAIC M1 or M1S
M1 or M1S Module Connections

Terminal Signal Description
1 24VDC 24VDC power supply
2* MASTER_ENABLE1 Master Enable 1
3* MASTER_ENABLE2 Master Enable 2
4 0VDC 0VDC power supply
5 OSSD1_A

Static output 1
6 OSSD1_B

7
RESTART_FBK Feedback/Restart 
OUT_STATUS Programmable signal output

8
RESTART_FBK Feedback/Restart
OUT_STATUS Programmable signal output

9 OSSD2_A
Static output 2

10 OSSD2_B

11
RESTART_FBK Feedback/Restart 
OUT_STATUS Programmable signal output

12
RESTART_FBK Feedback/Restart
OUT_STATUS Programmable signal output

13 OUT_TEST1 Short circuit detected output
14 OUT_TEST2 Short circuit detected output
15 OUT_TEST3 Short circuit detected output
16 OUT_TEST4 Short circuit detected output
17 INPUT1 Digital input 1
18 INPUT2 Digital input 2
19 INPUT3 Digital input 3
20 INPUT4 Digital input 4
21 INPUT5 Digital input 5
22 INPUT6 Digital input 6
23 INPUT7 Digital input 7
24 INPUT8 Digital input 8

* Terminals 2 and 3 are not connected on the M1S.
Note: The MOSAIC M1 or M1S Master Controller includes a USB 2.0 con-
nector for connection to a computer and the MSD (Mosaic Safety Designer) 
configuration software. A USB cable is available as an accessory.
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ReeR MOSAIC example

Controlling two safety devices with a
Light Curtain with automatic reset

Please refer to the Safety Components Disclaimer which follows these examples

MOSAIC M1 or M1S
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Specifying nodes when using multiple modules 
of the same type
(Example shows M1 used with four MI802 input/output expansion units)

Please refer to the Safety Components Disclaimer which follows these examples

NODE SEL NODE_SEL1 (Terminal 3) NODE_SEL0 (Terminal 2)
NODE 0 0 (or not connected) 0 (or not connected)
NODE 1 0 (or not connected) 24VDC
NODE 2 24VDC 0 (or not connected)
NODE 3 24VDC 24VDC

  NODE SEL
The NODE_SEL0 and NODE_SEL1 inputs (on the SLAVE units) are used to attribute a physical address to the 
slave units with the connections shown in the table below:

You cannot use the same physical address for multiple units 
of the same type. Each unit must have a unique address.NOTE

ReeR MOSAIC example
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ReeR MOSAIC example

Output blocks when using specific cards

The standard OSSD output block “OSSD,” which is used for most MOSAIC cards, will only 
allow for a dual-wire OSSD signal, as shown below.

The following cards utilize a different type of output:
	 • MOSAIC-M1S
	 • MOSAIC-MI804
	 • MOSAIC-MO4L
The output block “Single-Double OSSD” allows the use of a single-wire or dual-wire OSSD 
signal.
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Warning: Safety products sold by AutomationDirect are Safety components only.
The purchaser/installer is solely responsible for the application of these components and ensuring all 
necessary steps have been taken to assure each application and use meets all performance and appli-
cable safety requirements and/or local, national and/or international safety codes as required by the 
application. AutomationDirect cannot certify that our products used solely or in conjunction with other 
AutomationDirect or other vendors’ products will assure safety for any application.
Any person using or applying any products sold by AutomationDirect is responsible for learning the safe-
ty requirements for their individual application and applying them, and therefore assumes all risks, and 
accepts full and complete responsibility for the selection and suitability of the product for their respective 
application. AutomationDirect does not provide design or consulting services, and cannot advise whether 
any specific application or use of our products would ensure compliance with the safety requirements for 
any application.
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To configure the MBEI module, it must first be added to the module configuration with the Mosaic 
Safety Designer software.  Here’s how:

•	 Connect a USB cable to the M1 module.  

•	 In the Mosaic Safety Designer software, go to the Project menu and choose “Change 
Configuration.”  

•	 In an available slot, choose the “MB BUS” option at the top and select the “MBEI” option at the 
bottom.  

•	 Click on the Communication Menu and choose “Send configuration.”

Configuring the ReeR MBEI EtherNet/IP 
interface module
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Change the USB cable from the 
M1 module to the MBEI module to 
configure its settings and start the 
BUS Configurator software. 

Then click on the Connect 
button to view the current settings 
of the module.

The IP address and Subnet 
mask should be configured to 
be compatible with the subnet of 
the EtherNet/IP scanner/client 
device.  If the MBEI will need to 
be accessible through a router 
(via Explicit messaging), configure 
the Gateway address for the IP 
address of the router.  Typically, 
using the setting of “Auto” for the 
Baudrate will be sufficient for most 
devices as the port will negotiate 
to the proper setting.

Disable the Analog Data 
selection.  This will affect the size 
and could create an error with the IO Message connection.

Click on the Write button after the settings have been configured.

NOTE:  The MBEI module supports four concurrent TCP connections from TCP EtherNet/IP 
clients using Unconnected Messaging.  Any connection attempt when four connections exist 
will be denied.  Only one Class 1 IO Message or Class 3 Connected Explicit Message from 
a device is supported. 

Configuring the ReeR MBEI EtherNet/IP 
interface module

 (continued)
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How data is packed into the EtherNet/IP bytes

IO Messaging (Class 1 Connected)

Byte Offset Description

Output Data (O->T)

0 Fieldbus input byte 0

1 Fieldbus input byte 1

2 Fieldbus input byte 2

3 Fieldbus input byte 3

Input Data (T->O)

0 System status

1 Reserved

2 Input status byte 0

3 Input status byte 1

4 Input status byte 2

5 Input status byte 3

6 Input status byte 4

7 Input status byte 5

8 Input status byte 6

9 Input status byte 7

10 Input status byte 8

11 Input status byte 9

12 Input status byte 10

13 Input status byte 11

14 Input status byte 12

15 Input status byte 13

16 Input status byte 14

17 Input status byte 15

18 Fieldbus input feedback byte 0

19 Fieldbus input feedback byte 1

20 Fieldbus input feedback byte 2

21 Fieldbus input feedback byte 3

22 Probe status byte 0

23 Probe status byte 1

24 Probe status byte 2

25 Probe status byte 3

26 OSSD status byte 0

27 OSSD status byte 1

28 OSSD status byte 2

29 OSSD status byte 3
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How data is packed into the EtherNet/IP bytes 

(continued)
Explicit (Class 3 or Unconnected)

Input Data
Class: 162 (0xA2)

Instance: 1
Attribute: 5

Size: 30 bytes
Data Definition:

Same format as IO Message Input Data (T->O)

Output Data
Class: 162 (0xA2)

Instance: 257
Attribute: 5

Size: 4 bytes
Data Definition:

Same as IO Message Output Data (O->T)

CPU Errors 0CPU Errors 0
Class: 162 (0xA2)

Instance: 3
Attribute: 5

Size: 9 bytes
Data Definition:

Offset Byte Description Size (Bytes)
0 Module 1
1 Error Code 1
2 Error Address 4
6 Firmware Version 1
7 Extended Code 0 1
8 Extended Code 0 1

CPU Errors 1CPU Errors 1
Class: 162 (0xA2)

Instance: 4
Attribute: 5

Size: 9 bytes
Data Definition:

Offset Byte Description Size (Bytes)
0 Module 1
1 Error Code 1
2 Error Address 4
6 Firmware Version 1
7 Extended Code 0 1
8 Extended Code 0 1
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How data is packed into the EtherNet/IP bytes 

(continued)
Input Diagnostics

Class: 162 (0xA2)

Instance: 5

Attribute: 5

Size: 32 bytes

Data Definition:

Offset Byte Description Size (Bytes)

0 Diagnostic Index Error1 1

1 Diagnostic Code Error1 1

2 Diagnostic Index Error2 1

3 Diagnostic Code Error2 1

4 Diagnostic Index Error3 1

5 Diagnostic Code Error3 1

6 Diagnostic Index Error4 1

7 Diagnostic Code Error4 1

8 Diagnostic Index Error5 1

9 Diagnostic Code Error5 1

10 Diagnostic Index Error6 1

11 Diagnostic Code Error6 1

12 Diagnostic Index Error7 1

13 Diagnostic Code Error7 1

14 Diagnostic Index Error8 1

15 Diagnostic Code Error8 1

16 Diagnostic Index Error9 1

17 Diagnostic Code Error9 1

18 Diagnostic Index Error10 1

19 Diagnostic Code Error10 1

20 Diagnostic Index Error11 1

21 Diagnostic Code Error11 1

22 Diagnostic Index Error12 1

23 Diagnostic Code Error12 1

24 Diagnostic Index Error13 1

25 Diagnostic Code Error13 1

26 Diagnostic Index Error14 1

27 Diagnostic Code Error14 1

28 Diagnostic Index Error15 1

29 Diagnostic Code Error15 1

30 Diagnostic Index Error16 1

31 Diagnostic Code Error16 1
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How data is packed into the EtherNet/IP bytes 

(continued)
OSSD (Output) Diagnostics

Class: 162 (0xA2)

Instance: 6

Attribute: 5

Size: 32 bytes

Data Definition:

Offset Byte Description Size (Bytes)

0 Diagnostic Index Error1 1

1 Diagnostic Code Error1 1

2 Diagnostic Index Error2 1

3 Diagnostic Code Error2 1

4 Diagnostic Index Error3 1

5 Diagnostic Code Error3 1

6 Diagnostic Index Error4 1

7 Diagnostic Code Error4 1

8 Diagnostic Index Error5 1

9 Diagnostic Code Error5 1

10 Diagnostic Index Error6 1

11 Diagnostic Code Error6 1

12 Diagnostic Index Error7 1

13 Diagnostic Code Error7 1

14 Diagnostic Index Error8 1

15 Diagnostic Code Error8 1

16 Diagnostic Index Error9 1

17 Diagnostic Code Error9 1

18 Diagnostic Index Error10 1

19 Diagnostic Code Error10 1

20 Diagnostic Index Error11 1

21 Diagnostic Code Error11 1

22 Diagnostic Index Error12 1

23 Diagnostic Code Error12 1

24 Diagnostic Index Error13 1

25 Diagnostic Code Error13 1

26 Diagnostic Index Error14 1

27 Diagnostic Code Error14 1

28 Diagnostic Index Error15 1

29 Diagnostic Code Error15 1

30 Diagnostic Index Error16 1

31 Diagnostic Code Error16 1
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How data is packed into the EtherNet/IP bytes 

(continued)

CPU Errors 0CPU Errors 0
Class: 162 (0xA2)

Instance: 7
Attribute: 5

Size: 2 bytes
Data Definition:

Offset Byte Description Size (Bytes)
0 CRC Byte 0 1
1 CRC Byte 1 1
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Scroll towards the end of the document until the Module BUS ETHERNET_IP section is reached.  
The address mapping will be shown in this section.  This mapping will vary depending upon the 
hardware configuration.  

The MBEI module supports Class 1 IO Messaging, Class 3 Connected Explicit Messaging and Un-
connected Explicit Messaging.
Class 1 IO Messaging parameters:
•	 Input (T->O) Connection Point = 100 (0x64), size 30 bytes
•	 Output (O->T) Connection Point = 150 (0x96), size 4 bytes
•	 Configuration Data Connection Point = 5, Size 0 (The Configuration segment is optional for devices 

that support this).
•	 The 4-byte Status Header should be included in the Output data.
Class 3 Connected Explicit and Unconnected Explicit parameters:
•	 Input Data (Status data):

-	 Service = Get Single Attribute = 14 (0x0e)
-	 Class = 162 (0xa2)
-	 Instance = 1
-	 Attribute = 5
-	 Size = 30 bytes

•	 Output Data (FIELDBUS INPUT):
-	 Service = Set Single Attribute = 16 (0x10)
-	 Class = 162 (0xa2)
-	 Instance = 257
-	 Attribute = 5
-	 Size = 4 bytes

•	 Errors data CPU 0
-	 Service = Get Single Attribute = 14 (0x0e)
-	 Class = 162 (0xa2)
-	 Instance = 3
-	 Attribute = 5
-	 Size = 9 bytes

To view the EtherNet/IP byte mapping, change back to the Mosaic Safety 
Designer software and either open the project or connect back to the M1 module and open the 
project.  Click on the “Print Report” icon on the toolbar.  

NOTE: This is not the same as the Print functions under the File menu.

How to view the EtherNet/IP byte mapping
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•	 Errors data CPU 1
-	 Service = Get Single Attribute = 14 (0x0e)
-	 Class = 162 (0xa2)
-	 Instance = 4
-	 Attribute = 5
-	 Size = 9 bytes

•	 Input diagnostics
-	 Service = Get Single Attribute = 14 (0x0e)
-	 Class = 162 (0xa2)
-	 Instance = 5
-	 Attribute = 5
-	 Size = 32 bytes

•	 OSSD diagnostics
-	 Service = Get Single Attribute = 14 (0x0e)
-	 Class = 162 (0xa2)
-	 Instance = 6
-	 Attribute = 5
-	 Size = 32 bytes

•	 Project CRC
-	 Service = Get Single Attribute = 14 (0x0e)
-	 Class = 162 (0xa2)
-	 Instance = 7
-	 Attribute = 5
-	 Size = 2 bytes

How to view the EtherNet/IP byte mapping
(continued)
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NOTE:  Everything past offset byte 29 does not exist in the ADC version of the M1 and 
should be ignored.

Data mapping
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Data mapping
(continued)
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Data mapping
(continued)
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In the previous section that details the bit breakdown, notice that the description for each section is 
correlated to the Byte offset at the beginning of the EtherNet/IP Mapping details.  

An illustration of this is shown below:

NOTE: The final section describes an older style mapping for units prior version 2.0.  This 
will NOT apply to ADC units.

Data mapping
(continued)
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The Input Diagnostics are read by using Explicit Messaging to Class 162 (0xa2), Instance 5, 
Attribute 5.  The Input diagnostics can display 16 possible errors.  Each error has a IO Index 
value to display which device is in error and the Diagnostic Code which is the actual error 
code.  The values for the IO Index are shown in the Print Report.  The error codes for the Inputs are shown below.  The most 
recent error is at the top of the list (lowest byte offset).  As the errors are corrected, they move up the table.

OSSD Diagnostics
0 Input Diagnostics OK

1 Not moved from zero
Both switches have to go to rest condition. 

This error is commonly seen when one of the required Inputs from a device 
is missing.

2 Concurrent failed Both switches have to change state simultaneously

3 Concurrent failed hand 1 Wrong connection on one side of a two-hands switch

4 Concurrent failed hand 2 Wrong connection on one side of a two-hands switch

7 Switch inconsistent The selector should not have more than one input set

8 Switch disconnected The selector should have at least one input set

10 OUT_TEST error OUT_TEST diagnostics present on this input

11 Second input KO Redundancy check failed on input

12 OUT_TEST diagnostics OK

13 Output connected to other inputs Test output not connected to the right input

14 Output OK but input connected to 24VDC Stuck input

15 Short circuit between photocell test 
and photocell input Photocell response time too slow

16 No response from photocell The test signal on the photocell emitter is not seen on the receiver

17 Short circuit between photocells The test signal is present on two different photocells

18 MAT disconnected Wrong mat connection

19 Output inconsistent with feedback The test signal on input is present on more than one OUT_TEST

20 Connection incorrect The test signal is present on more than one input

21 Output stuck The test signal on the input is not present on the OUT_TEST

22 Second OUT_TEST KO Redundancy check failed on OUT_TEST

23 MV2 proximity mnissing Proximity not present/Proxy not working

24 MV2 encoder missing Encoder not present/Encoder not powered

25 MV2 encoder Proximity missing Device connected incorrectly

26 MV2 Proximity 1, Proximity 2 missing Both proxies must be connected

27 MV2 encoder 1, encoder 2 missing Both encoders must be connected

28 MV2 error congruence frequencies Redundancy check failed on measurement
29 MV2 encoder supply missing Encoder not properly fed
30 MV2 encoder error Encoder signals with duty cycle and/or phase displacement not correct

*133 (0x85) TWO-HAND concurrent failed Two-hands switch has to change state simultaneously
*134 (0x86) Not started Start test failed
*137 (0x89) Waiting for restart The input has manual reset and has not been restarted

* Diagnostic values 133, 134 and 137 do not provide visual error message on the LED Mosaic.

Input diagnostics
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The Output (or OSSD) Diagnostics are read by using Explicit Messaging to Class 162 
(0xa2), Instance 6, Attribute 5.  The Output diagnostics can display 16 possible errors.  
Each error has a IO Index value to display which device is in error and the Diagnostic 
Code which is the actual error code.  The values for the IO Index are shown in the Print Report.  The error codes for the 
Outputs are shown below.  The most recent error is at the top of the list (lowest byte offset).  As the errors are corrected, 
they move up the table.

OSSD Diagnostics
0 OSSD diagnostics OK

1 Enable missing

2 Waiting for restart OSSD

3 Feedback K1/K2 missing

4 Waiting for other micro Redundancy check failed on OSSD

5 OSSD power supply missing

6 Exceeded maximum time restart

7 Feedback K1/K2 external not congru-
ous CAT2

Applicable to MOR4 MOR458 modules configured in CAT2

8 Waiting for feedback K1/K2 Feedback K1 K2 in transition

9 Overload OSSD output

10 OSSD with Load set to 24V

Output diagnostics
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Productivity Series Example
Class 1 IO Messaging

Go to Hardware Configuration and click on the EtherNet/IP tab.  Click on the Generic 
Client text on the right-hand side and drag over to the working area to create a new device.
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Productivity Series Example
Class 1 IO Messaging 
(continued)

Fill in the IP address of the MBEI module.  Click on the + and choose Add IO message.  Click on 
the T->O (INPUT) tab and fill in as shown below.
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Productivity Series Example
Class 1 IO Messaging 
(continued)

Click on the O->T (OUTPUT) tab and fill in as shown below.
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Productivity Series Example
Class 1 IO Messaging 
(continued)
Click on the CONFIG DATA tab.  Leave this option disabled.  It will also work if you enable this 
option, enter in a value of 5 for the Assembly Instance/Connection Point field and choose 
number of elements 0.
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Notice the mapping of the bits below as compared to the Print Report illustrated earlier in this 
document.  Note that the Print Report utilizes an offset into the data starting at 0 while the Productivity 
Series PLC uses an offset of 1.

Productivity Series Example
Class 1 IO Messaging 
(continued)
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Productivity Series Example
Class 3 Explicit (or Unconnected Explicit)

In the example below, there is only one “write” (SET).  It is only triggered when a change to the value 
of the FIELDBUS INPUTs is desired.  The ‘read’ (GET) instructions are polled on a 250ms interval by 
using a simple counter to increment through the 5 instructions.  There are additional permissive bits 
for each of the GET instructions.
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Productivity Series Example
Class 3 Explicit (or Unconnected Explicit) 
(continued)

The final rung moves over the Diagnostic IO Index and error code.  The example shows only the first 
error location for each diagnostic block of 16 (Input and Output).  To break out all 16 errors, repeat the 
example for all 16 locations.
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Do-more/BRX Example

Do-more and BRX PLCs only do Unconnected Explicit Messaging.  The “write” (SET) instruction is 
triggered only when the FIELDBUS INPUT values change.  Unsigned words (V registers) are used for 
the source and destination data in this example.  The bit of word assignments is shown at the end of 
this example to illustrate where the bits map into the data being read and written.  They correspond to 
the mapping in the Print Report shown earlier in this document.
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Do-more/BRX Example
(continued)

The last two rungs break out the diagnostic IO Index and error code to make it easier to read.  These 
two rungs only break out the first error for each block (Inputs and Outputs).  To break out all 16 errors 
for each block, use the same method shown in these rungs for all 16 registers.



40

Do-more/BRX Example
(continued)

This table shows the bit-of-word mapping.
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To configure the MBEM module, it must first be added to the module configuration with the Mosaic 
Safety Designer software.  Here’s how:

•	 Connect a USB cable to the M1 module.  

•	 In the Mosaic Safety Designer software, go to the Project menu and choose “Change 
Configuration.”  

•	 In an available slot, choose the “MB BUS” option at the top and select the “MBEM” option at the 
bottom.  

•	 Click on the Communication Menu and choose “Send configuration.”

Configuring the Reer MBEM Modbus 
TCP interface module
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The IP address and Subnet mask should be configured to be compatible with the subnet of the 
Modbus TCP client device.  
If the MBEM will need to be accessible through a router, configure the Gateway address for the IP 
address of the router.  

The MBEM module listens on the 
standard Modbus TCP port 502.

The Baudrate section can be 
used to change the Ethernet port 
settings.  Typically, using the Auto 
setting will be sufficient for most 
devices as the port will negotiate to 
the proper setting.

Click on the Write button after the 
settings have been configured.

Click on the Connect 
button to view the current 
settings of the module.

NOTE: The MBEM module supports four concurrent Modbus TCP connections from 
Modbus TCP clients.  Any connection attempt when four connections exist will be denied.

Change the USB cable from the M1 module to the MBEM module to 
configure its settings and start the 
BUS Configurator software. Then...

Configuring the Reer MBEM Modbus 
TCP interface module
(continued)
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This table shows a basic layout of how the data is packed into the Modbus 
registers.

Modbus Addressing
Description Read/Write

Mosaic Modicon Style Protocol                  
(FC = Function Code)

000h 400001 FC3/6/16 Offset 0 Fieldbus input bytes 1/0 (High/Low) Write

001h 400002 FC3/6/16 Offset 1 Fieldbus input bytes 3/2 (High/Low) Write

002h - 0FFh 400003 - 400256 FC3/6/16 Offset 2 - 255 Reserved Write

100h 400257 FC3 Offset 256 System Status (low byte) Read

101h 400258 FC3 Offset 257 Input status bytes 1/0 (High/Low) Read

102h 400259 FC3 Offset 258 Input status bytes 3/2 (High/Low) Read

103h 400260 FC3 Offset 259 Input status bytes 5/4 (High/Low) Read

104h 400261 FC3 Offset 260 Input status bytes 7/6 (High/Low) Read

105h 400262 FC3 Offset 261 Input status bytes 9/8 (High/Low) Read

106h 400263 FC3 Offset 262 Input status bytes 11/10 (High/Low) Read

107h 400264 FC3 Offset 263 Input status bytes 13/12 (High/Low) Read

108h 400265 FC3 Offset 264 Input status bytes 15/14 (High/Low) Read

109h 400266 FC3 Offset 265 Fieldbus input feedback bytes 1/0 (High/Low) Read

10Ah 400267 FC3 Offset 266 Fieldbus input feedback bytes 3/2 (High/Low) Read

10Bh 400268 FC3 Offset 267 Probe status bytes 1/0 (High/Low) Read

10Ch 400269 FC3 Offset 268 Probe status bytes 3/2 (High/Low) Read

10Dh 400270 FC3 Offset 269 OSSD status bytes 1/0 (High/Low) Read

10Eh 400271 FC3 Offset 270 OSSD status bytes 3/2 (High/Low) Read

10Fh - 110h 400272 - 400273 FC3 Offset 271 - 272 Analog data float 0 Read

111h - 112h 400274 - 400275 FC3 Offset 273 - 274 Analog data float 1 Read

113h - 114h 400276 - 400277 FC3 Offset 275 - 276 Analog data float 2 Read

115h - 116h 400278 - 400279 FC3 Offset 277 - 278 Analog data float 3 Read

117h - 118h 400280 - 400281 FC3 Offset 279 - 280 Analog data float 4 Read

119h - 11Ah 400282 - 400283 FC3 Offset 281 - 282 Analog data float 5 Read

11Bh - 11Ch 400284 - 400285 FC3 Offset 283 - 284 Analog data float 6 Read

11Dh - 11Eh 400286 - 400287 FC3 Offset 285 - 286 Analog data float 7 Read

11Fh - 120h 400288 - 400289 FC3 Offset 287 - 288 Analog data float 8 Read

121h - 122h 400290 - 400291 FC3 Offset 289 - 290 Analog data float 9 Read

123h - 124h 400292 - 400293 FC3 Offset 291 - 292 Analog data float 10 Read

125h - 126h 400294 - 400295 FC3 Offset 293 - 294 Analog data float 11 Read

127h - 128h 400296 - 400297 FC3 Offset 295 - 296 Analog data float 12 Read

129h - 12Ah 400298 - 400299 FC3 Offset 297 - 298 Analog data float 13 Read

12Bh - 12Ch 400300 - 400301 FC3 Offset 299 - 300 Analog data float 14 Read

12Dh - 12Eh 400302 - 400303 FC3 Offset 301 - 302 Analog data float 15 Read

12Fh - 22Fh 400304 - 400560 FC3 Offset 303 - 559 Reserved Read

230h 400561 FC3 Offset 560 Error CPU0 bytes Error Code/Module (High/Low) Read

231Fh - 232h 400562 - 400563 FC3 Offset 561 - 562 Error CPU0 Error Address Read

233h 400564 FC3 Offset 563 Error CPU0 bytes Firmware Ver/Extended Code 0 (High/Low) Read

234h 400565 FC3 Offset 564 Error CPU0 byte Extended Code 1 (Low) Read

235Fh - 23Fh 400566 - 400576 FC3 Offset 565 - 575 Reserved Read

How data is packed into the Modbus registers
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Modbus Addressing
Description Read/Write

Mosaic Modicon Style Protocol                  
(FC = Function Code)

240h 400577 FC3 Offset 576 Error CPU1 bytes Error Code/Module (High/Low) Read

241Fh - 242h 400578 - 400579 FC3 Offset 577 - 578 Error CPU1 Error Address Read

243h 400580 FC3 Offset 579 Error CPU1 bytes Firmware Ver/Extended Code 0 (High/Low) Read

244h 400581 FC3 Offset 580 Error CPU1 byte Extended Code 1 (Low) Read

245Fh - 24Fh 400582 - 400592 FC3 Offset 581 - 591 Reserved Read

250h 400593 FC3 Offset 592 Input diagnostic 1 bytes index/code (High/Low) Read

251h 400594 FC3 Offset 593 Input diagnostic 2 bytes index/code (High/Low) Read

252h 400595 FC3 Offset 594 Input diagnostic 3 bytes index/code (High/Low) Read

253h 400596 FC3 Offset 595 Input diagnostic 4 bytes index/code (High/Low) Read

254h 400597 FC3 Offset 596 Input diagnostic 5 bytes index/code (High/Low) Read

255h 400598 FC3 Offset 597 Input diagnostic 6 bytes index/code (High/Low) Read

256h 400599 FC3 Offset 598 Input diagnostic 7 bytes index/code (High/Low) Read

257h 400600 FC3 Offset 599 Input diagnostic 8 bytes index/code (High/Low) Read

258h 400601 FC3 Offset 600 Input diagnostic 9 bytes index/code (High/Low) Read

259h 400602 FC3 Offset 601 Input diagnostic 10 bytes index/code (High/Low) Read

25Ah 400603 FC3 Offset 602 Input diagnostic 11 bytes index/code (High/Low) Read

25Bh 400604 FC3 Offset 603 Input diagnostic 12 bytes index/code (High/Low) Read

25Ch 400605 FC3 Offset 604 Input diagnostic 13 bytes index/code (High/Low) Read

25Dh 400606 FC3 Offset 605 Input diagnostic 14 bytes index/code (High/Low) Read

25Eh 400607 FC3 Offset 606 Input diagnostic 15 bytes index/code (High/Low) Read

25Fh 400608 FC3 Offset 607 Input diagnostic 16 bytes index/code (High/Low) Read

260h 400609 FC3 Offset 608 Output diagnostic 1 bytes index/code (High/Low) Read

261h 400610 FC3 Offset 609 Output diagnostic 2 bytes index/code (High/Low) Read

262h 400611 FC3 Offset 610 Output diagnostic 3 bytes index/code (High/Low) Read

263h 400612 FC3 Offset 611 Output diagnostic 4 bytes index/code (High/Low) Read

264h 400613 FC3 Offset 612 Output diagnostic 5 bytes index/code (High/Low) Read

265h 400614 FC3 Offset 613 Output diagnostic 6 bytes index/code (High/Low) Read

266h 400615 FC3 Offset 614 Output diagnostic 7 bytes index/code (High/Low) Read

267h 400616 FC3 Offset 615 Output diagnostic 8 bytes index/code (High/Low) Read

268h 400617 FC3 Offset 616 Output diagnostic 9 bytes index/code (High/Low) Read

269h 400618 FC3 Offset 617 Output diagnostic 10 bytes index/code (High/Low) Read

26Ah 400619 FC3 Offset 618 Output diagnostic 11 bytes index/code (High/Low) Read

26Bh 400620 FC3 Offset 619 Output diagnostic 12 bytes index/code (High/Low) Read

26Ch 400621 FC3 Offset 620 Output diagnostic 13 bytes index/code (High/Low) Read

26Dh 400622 FC3 Offset 621 Output diagnostic 14 bytes index/code (High/Low) Read

26Eh 400623 FC3 Offset 622 Output diagnostic 15 bytes index/code (High/Low) Read

26Fh 400624 FC3 Offset 623 Output diagnostic 16 bytes index/code (High/Low) Read

270h 400625 FC3 Offset 624 Project CRC bytes Low/High (High/Low) Read

How data is packed into the Modbus registers
(continued)
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Scroll towards the end of the document until the Module BUS MODBUS TCP section is reached.  The 
Modbus address mapping will be shown in this section.  This Modbus mapping will vary depending upon the 
hardware configuration.

The Fieldbus input byte description describes bits that can be written to by a Modbus TCP Client de-
vice.  All of the other registers are status data to be read by the Modbus TCP Client device.

Scrolling down further shows a more detailed breakdown of the data contained within these Modbus registers:

To view the Modbus address mapping, change back to the Mosaic Safety Designer 
software and either open the project or connect back to the M1 module and open the 
project.  Click on the Print Report icon on the toolbar. 

NOTE: This is not the same as the Print functions under the File menu.

How to view Modbus address mapping
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How to view Modbus address mapping
(continued)
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How to view Modbus address mapping
(continued)
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How to view Modbus address mapping
(continued)
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In the previous section that details the bit breakdown, notice that the description for each section is 
correlated to the Byte offset at the beginning of the Modbus TCP/IP Mapping details.  

An illustration of this is shown below:

NOTE: The final section describes an older style mapping for units prior version 2.0.  This 
will NOT apply to ADC units.

How to view Modbus address mapping
(continued)
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Registers 250h-25Fh contain the Input diagnostic errors.  The High byte points to the 
device that has an error (note the device numbers shown in the Input Diagnostic section 
in the Print Report output).  The Low byte contains the error code itself.  The table below 
indicates the possible errors, their explanations and possible resolutions for these errors.

OSSD Diagnostics
0 Input Diagnostics OK

1 Not moved from zero
Both switches have to go to rest condition. 

This error is commonly seen when one of the required Inputs from a device 
is missing.

2 Concurrent failed Both switches have to change state simultaneously

3 Concurrent failed hand 1 Wrong connection on one side of a two-hands switch

4 Concurrent failed hand 2 Wrong connection on one side of a two-hands switch

7 Switch inconsistent The selector should not have more than one input set

8 Switch disconnected The selector should have at least one input set

10 OUT_TEST error OUT_TEST diagnostics present on this input

11 Second input KO Redundancy check failed on input

12 OUT_TEST diagnostics OK

13 Output connected to other inputs Test output not connected to the right input

14 Output OK but input connected to 
24VDC Stuck input

15 Short circuit between photocell test and 
photocell input Photocell response time too slow

16 No response from photocell The test signal on the photocell emitter is not seen on the receiver

17 Short circuit between photocells The test signal is present on two different photocells

18 MAT disconnected Wrong mat connection

19 Output inconsistent with feedback The test signal on input is present on more than one OUT_TEST

20 Connection incorrect The test signal is present on more than one input

21 Output stuck The test signal on the input is not present on the OUT_TEST

22 Second OUT_TEST KO Redundancy check failed on OUT_TEST

23 MV2 proximity mnissing Proximity not present/Proxy not working

24 MV2 encoder missing Encoder not present/Encoder not powered

25 MV2 encoder Proximity missing Device connected incorrectly

26 MV2 Proximity 1, Proximity 2 missing Both proxies must be connected

27 MV2 encoder 1, encoder 2 missing Both encoders must be connected

28 MV2 error congruence frequencies Redundancy check failed on measurement
29 MV2 encoder supply missing Encoder not properly fed
30 MV2 encoder error Encoder signals with duty cycle and/or phase displacement not correct

*133 (0x85) TWO-HAND concurrent failed Two-hands switch has to change state simultaneously
*134 (0x86) Not started Start test failed
*137 (0x89) Waiting for restart The input has manual reset and has not been restarted

* Diagnostic values 133, 134 and 137 do not provide visual error message on the LED Mosaic.

Registers 250h-25Fh (input diagnostic errors)
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Registers 260h – 26Fh contain the Output diagnostic errors.  The High byte points to the device that has an error (note the 
device numbers shown in the Output Diagnostic section in the Print Report output).  The Low byte contains the error code 
itself.  The table below indicates the possible errors, their explanations and possible resolutions for these errors.

OSSD Diagnostics
0 OSSD diagnostics OK

1 Enable missing

2 Waiting for restart OSSD

3 Feedback K1/K2 missing

4 Waiting for other micro Redundancy check failed on OSSD

5 OSSD power supply missing

6 Exceeded maximum time restart

7 Feedback K1/K2 external not congru-
ous CAT2

Applicable to MOR4 MOR458 modules configured in CAT2

8 Waiting for feedback K1/K2 Feedback K1 K2 in transition

9 Overload OSSD output

10 OSSD with Load set to 24V

Registers 260h-26Fh (output diagnostic errors)
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Productivity Series Example
The example uses the device mapping from the Print Report example 
shown earlier in this document.

Note that the Print Report starts at offset 0 but the Productivity Series starts at offset 1.
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Productivity Series Example
(continued)
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CLICK Example
Since CLICK does not support bit of word, COPY instructions are used to 
move over the register values in the DH addresses to C bits.  Nicknames 
are assigned to show where the bits are mapped to the registers.  

This example uses the mapping from the example Print Report illustrated earlier in this document.
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CLICK Example
(continued)
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CLICK Example
(continued)
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CLICK Example
(continued)
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CLICK Example
(continued)
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CLICK Example
(continued)
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Do-more/BRX Example
Bit of word was utilized for this example to make the code easier.  The 
nickname assignments to the correct bit of words are shown at the end of 
the code.  

This mapping was derived from the example Print Report illustrated earlier in this document.
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Do-more/BRX Example
(continued)
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Do-more/BRX Example
(continued)


